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Things to Mastering More Advanced Appendices

Remember the Basics Techniques

About this Manual

Notation Conventions

The contents of this manual are classified according to the following symbols.

(1) IMPORTANT

e The “Important” sections contain operating precautions or important topics.
Ensure that you read them.

@ HINT ]

e The "Hint"” sections contain procedural suggestions and tips for your convenience. Read them as
necessary.

Operating Environment

® This manual uses Mac OS X v10.5 screen shots and procedures in the explanations.
The screen shots and procedures may appear slightly different if you are using
another version of Mac OS.

e The displayed screens and procedures may also differ slightly from the examples
depending upon the camera or printer model in use.

e The explanations in this guide are based on the premise that a Canon compact
digital camera will be used with the software.

e Some functions may not be available depending on the camera model.

Word Searches

This document is provided as an Adobe Reader document. Use Adobe Reader’s Search
functions to find specific words or phrases that you recall but cannot find. To access
this function, in Adobe Reader click the [Edit] menu and select the [Search] option.

If you are using Adobe Reader 8 or later, you can also perform searches with the [Find]
function right on the toolbar.

® Adobe Reader File Edit View Document Tools Window Help

_
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Input search text here
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Remember the Basics Techniques Appendices

Precautions for Connecting the Camera to the Computer

e \WWhen connecting the camera to the computer with an interface cable, make sure to connect
the cable directly to the computer’s USB port. The connection may not operate correctly if
you attach the camera to the computer via a USB hub.

e The connection may not operate correctly if you are using other USB devices, excluding
USB mice or keyboards, at the same time as the camera. If this occurs, disconnect the other
devices from the computer and try reconnecting the camera.

* Do not connect two or more cameras at the same time to the same computer. The
connections may not operate correctly.

* Do not allow the computer to go into sleep (standby) mode while a camera is connected
via the USB interface cable. If this does happen, do not disconnect the interface cable. Try
to awaken the computer with the camera in the connected state. Some computers will not
awaken properly if you disconnect the camera while they are in sleep (standby) mode. Please
refer to your computer manual for instructions regarding the sleep (standby) mode.

* Do not disconnect the camera from the computer if CameraWindow is displayed on the
screen.

{1) IMPORTANT

e You are recommended to use an AC adapter (sold separately) when connecting
to a computer. Ensure that you use fully charged batteries if you cannot use an
AC adapter.

* See the Camera User Guide for procedures on connecting the camera to the
computer.
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Things to

Remember

The Two ImageBrowser Windows

Windows That Communicate With the Camera and Manage Images

The following two windows are the main ones used for ImageBrowser procedures.

Transfer window, which opens when a camera is connected.
CameraWindow &

O

~—

You can transfer all or a selection of images from the connected camera.

CameraWindow closes and the screen changes
after the images are transferred from the camera.

Organizing window for transferred images.
Browser Window

= 2] ¥iman g s

Click this icon
in the Dock.

Double-click

: an image. .
WEEEr
| - = T AA = B &

= 4 = 3 =&

| e — Came Lpmen - I bt ¢ el =

[E———————— 5o

You can view, edit and print the images in the The Viewer Window that
computer. appears when you view
an image.

@ HINT

Use the Help Function
The i (Help) button or Help menu is available in most CameraWindow and ImageBrowser windows. It is
there for when you are unsure how to proceed.

‘L'-‘ .. - ¢ ?D
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Browser Window

How to Display the Browser Window

Browser Window will appear after the camera images are transferred and
CameraWindow closes. You can also display it by clicking the ImageBrowser icon in the
Dock (the bar at the bottom of the desktop).

e |f the ImageBrowser icon is not displayed in the Dock, double-click
the [Applications] folder, followed by the [Canon Utilities] folder,
[ImageBrowser] folder and the [ImageBrowser] icon.

Names of the Browser Window Parts

Browser Area
Icons that indicate image properties
display around thumbnail images, as

Menu Bar Display Modes shown on the bottom left.
it Acauires imiges
+ ) Shaw All Imaget
" Droneatl
Last Acquired Images v-;,m;w
Displays the last images
transferred.
Folder Area

Selects a folder to display.

. . . . Display Control Panel
Properties Icon (Displays image properties)

Ol : Image recorded using the camera’s Stitch Assist mode Control Panel
Ve - RAW image
- \ovie

[J] :Image with sound memo attached

[Ex] : Protected image

By :Image recorded using the camera’s AEB function
E : Rotated image (rotated in display only)

—m— N . 0\
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How to Perform Tasks

Selecting and Using Functions

Many ImageBrowser functions can be accessed by selecting them from the Control
Panel and following the instructions in the guidance section of the new window. For
further details on the functions, refer to “List of Available Functions” in the appendix.

" Select a function from the Control Panel or a menu.

Bave A oXs
Maw Folder ®N
Favorite Folders "
Gl I w1
Copy Image...
Move Image...
[’ Duplicars £
e Rename..
ﬂ E @ l ‘ Send to Trash wE
Canon Camara Vigw image sligeshow Pring & Envil Send 19 Trash Search... HF
ok Export Image....
m o 1/ Tonah & images >
Index Print... I iﬁ[ﬂn::}l\mu: ) g *
Precess BAW Images oy Diglal Photwo Professions
Layout Prin.... Processing AW krge
| Create Image for Emall_..
Yy A - Connedt ta Camera...
Rewrite Image to Memory Card....

Index Print,..
Sound * Layout Print..,
- R

)| Printer

[ 1000000000( i
{ Pagesetup.. )

Paper size -

WS Letter

Click [Page Setup] to enable
borderless printing on
‘ supported printers,

2 Follow the instructions ... . .....
to perform the task. T 9

PFropertics.

B Remove unwanted regions of 3 | Addar Mindify tent to print with
| '_-_i!_, your photo, | tﬂ;| this phota,

4 E Image: 1/3 cmu:g@ Total :  3Jpages

(A Tobte o ontens ) < s )




Transferring Images

Transferring Images by Connecting the Camera to a Computer

Transfer the camera images to the computer.

(1) IMPORTANT

* The instructions in this software manual assume that you have correctly installed
the software. See the Camera User Guide for software installation procedures.

¢ For details on how to connect the camera to a computer, refer to the Camera
User Guide. Please also refer to “Precautions for Connecting the Camera to the
Computer”.

¢ If CameraWindow fails to open when you connect the camera, click the
[CameraWindow] icon in the Dock (the bar at the bottom of the desktop).

" Connect the camera to the computer with
the supplied interface cable.

2 Turn on the camera power, set it to
playback mode and prepare it to
communicate with the computer.

3 Click [Import Images from
Camera] and then click [Import
Untransferred Images].

Only images that have not yet been
transferred will start to transfer.

€
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the Basics

After you click [OK] in the dialog that indicates the transfer is complete and
close the CameraWindow screen, the transferred images will display in the
Browser Window.

You can select the newly transferred
images by their shooting dates or My
Category (select models only) classification.

[§ : Folders containing
newly acquired images

i R T N

D e p—

* Images from memory cards with large numbers of images (more than 1,000) may not transfer
correctly. If this happens, please use a memory card reader to transfer. For details on transferring
images from a memory card reader, refer to “Transferring Images Using a Memory Card Reader”.

e Movie files take time to transfer since the files are large.

~ @ HINT

Changing the Transfer Destination Folder

The default settings save transferred images into the
[Pictures] folder. To change the destination folder, click
the @ button shown on the right in Step 3 as described
on the previous page, then click the [Import] button. In
[Folder Settings], click [Browse] to complete settings in the
screen currently displayed.

< 10 )
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~ @ HINT |

Select Images to Import
To transfer only a selection of images from
the camera, click [Import Images from
Camera] in CameraWindow (menu screen),
then select images in the image transfer
screen, and click the | 41| (Import) button.

For details, refer to “Image Transfer Screen”.

Import All Images
To transfer all images on the camera,

click [Import Images from Camera] in
CameraWindow (menu screen) then, [Import
All Images].

Automatically Transferring Images on
ImageBrowser Start-Up

To automatically transfer images when
CameraWindow starts up, click the button
shown on the right in CameraWindow
(menu screen), then click the [Import]
button, and [Auto Import]. Add a checkmark
to [Start importing images automatically
when this software is launched.].

Transferring Images Using a Memory Card Reader
ImageBrowser will start when you insert a memory card into the memory card reader, and display the
following window. Use this window to perform the transferring procedures.

ImageBrowser

Transfers all images.

Lets you select and i
Sonioed B Allows you to select and transfer images.

Print Menu Prints images.

Configures the transfer folder and
other settings.

(A oo of conters ) <« )
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Printing

Printing a Single Image on a Single Page

Prints one image per page.

@ HINT

Printing Movies
Movies cannot be printed, but you can extract still images from movies, and print them after they have
been saved. For details on how to save still images from movies, refer to “Extracting Stills from Movies”.

" Select images for printing.

limz0on o007
(o0, o8 o8
\E2009_08_08%
[eoon o810
Lan0n 0811

Click [Print & Email], and
[Photo Print].

IMC_0003 JFC IMG_0004 JPG IMC_0005 PG

=l 3 =

Salecting | b
||||||||a‘@‘“ e |

& = 3
lideShow w

Iggted: 3 [ Total: 5 images -

Layout Print...
Create Image for Email...

< 2 p)
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3 Set the categories as desired.

Sets the printer, paper

size and borderless m—
printing settings. [ X0000GO00¢ ]
(s )
‘ Paper size ;
US Letrer

Click [Fage Setup] to enable
borderless printing on
supported printers,

Sets the shooting Shaating Date/Time
date/time imprint (None ]
Settings. ( I"'ropem!jr..._.._ A ¢
ve unwanted regions of l g Add or Modify text to print with
hata. . this photo.

,ﬁﬁﬁ:; 1|@ Total :  3pages
C Clome } ( Print ) P

Click here to Click here to insert
crop and print text onto an image
a portion of an and print.
image.
4 Click [Print].
Print window will display.
5 Click [Print].
Printing will start.
~ @ HINT |

Laying Out and Printing

You can also select multiple images, add captions and print freely composed layouts on a single page.
Click [Print & Email] in the Control Panel and select [Layout Print]. The shooting date will automatically
appear when you perform a layout print if you click the [ImageBrowser] menu, followed by [Preferences]
. and [Layout Print], and place a check mark beside [Shooting Date].

- 13 ?9
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Index Print

Prints an index of the images.

" Select images for printing.

Click [Prir_lt & Email], and S P o
[Index Print]. E— yls
[ N T T T Ea\ (a\ “ Lalecting Images ¥ | @ @

& a 3

ilideshow Print & Email Send to Trash

-iekeed: 7 / Total 9 images

J
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Set the categories as desired.

Select an image to rotate or trim.

Printer

Sets the printer, paper
size and number of
print copies settings.

Name:
[ XK00eK 3!

Paper size -
US Letter
Origntation.  Portrait

On printers that support borderless
printing, this feature is nat
recommended.Click [Page Setup] to
‘change this setting,

Sets the number of
rows or columns.

Configures the printing of
the shooting information,
comments, headers,

footers or page numbers.

P

| @ 2#;;; 1/1

®

= L
Rowele  RouwRgh T image
I

Click [Print].
Print window will display.

Click [Print].
Printing will start.

 Cose | Pim )

<

Rotates selected
images.

Click here to crop a portion of the
selected image and print it.

‘ .‘ { Table of Contents )
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How to Use CameraWindow

First Menu Screen to Open

This screen appears when the camera is connected to your computer.
Click each button to display the available options.

Displays in-camera
memory card
information. Displays camera information.

Card Capatity:
663 MBY 1.83 GB
T

Untranferred Inigee: 718/ 298

Starts operations for
transferring images from the
camera to your computer.

Starts operations for
protecting, rotating, and
deleting images on the
camera. Also transfers images
from your computer to the
camera.

Starts operations for
uploading movies on the
camera to web services.

Starts operations for setting
the camera start-up screen,
start-up sound, and various
camera sounds. For details,
refer to "My Camera
Settings” in “More Advanced
Techniques”. This menu may
not appear depending on your
camera model.

@ HINT

Customizing CameraWindow Functions

If you click the g button as shown in the upper right of the screen, you can customize various functions
to make CameraWindow easier to use. You can change the automatic transfer settings, the start-up
screen that appears when starting CameraWindow, and the transfer destination folder.

= IS
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Image Transfer Screen

This screen appears when you click [Import Images from Camera] on the Menu screen,
then click [Select Images to Import]. Select the image you want to transfer and click
the W button to transfer the image to your computer.

Viewer Window (thumbnail display) E Turns the shooting date and folder name below the
thumbnails on and off (when in thumbnail display).

Closes CameraWindow.

Changes thumbnail size

Returns to the Menu screen. , ok
(when in thumbnail display).

Switches between window display
modes.

[EJ Thumbnail display

Preview display

3 M J 103 G

Uneransfeered images: 2346 /238

£ Al Images [Xx%]
) Untransferred Images [XX»

* I Date Shat -l Full screen display
v & 2000 (Xxx] . , . X
b 3 09 [0 Double-clicking an image switches
0 o7 pox to preview display when a single
9% poy image is selected.
109 [xxx]

1 10 [xxx]
11 [xxx]

¥ 10 Image Type

— This mark appears on images that

= JPEG Image [XXX]
have not yet been transferred.

=) RAW Image [%xX]

B Mavie (] "1 —F : % ﬁ -

- i Posts TWE R 2l [ .
=
All Cluar Impmi

Eotate ko he Eaiate to the
ift

T Transfers the image chosen
+ . in Viewer Window to your
computer.

W right

—_—

Images on the camera
that match the selected
filter display in the area

Cancels image selection.

to the right. oo Selects all images.
[S[=]
Rotates chosen images .
.O . .O | 90° to the left or right. The background of chosen images turns blue.

(1) IMPORTANT
e The functions (buttons) that display will differ depending on the camera model.

(A)ebre of Contents ) « 17 p)




Organize Images Screen

This screen appears when you click [Organize Images on Camera] on the Menu screen,
then click [Organize Images]. Clicking a folder on the left will display all images within
the folder as thumbnails (small images) on the right of the screen.

Viewer Window (thumbnail display) E Turns the shooting date and folder name below the
thumbnails on and off (when in thumbnail display).

Closes CameraWindow.

Changes thumbnail size

Returns to the Menu screen. , ok
(when in thumbnail display).

Switches between window display
modes.

[EJ Thumbnail display
Preview display
-l Full screen display

Double-clicking an image switches
to preview display when a single
image is selected.

3 M J 103 G

Uneramsfereed images: 235/ 238

3 Al Images [X3]
) Untransferred Images [XX»
* I3 Date Shot
v = 2000 (Xxx]
» 5 00 (00
1 07 [%xx]
71 08 [X¥x]
1 09 [xxx]
=1 10 [xxX]
0 11 [%xx]
¥ 10 Image Type
= JPEG Image [XXX]
=) RAW Image [%xX]

e W e W —
0 o B

Eotate ko he Eaiate to the
ift

— This mark appears on images that
have not yet been transferred.

% Deletes the image chosen
. in Viewer Window.

o e Viptoad Predert

[ Protects/cancels protection
Images on the camera e . for the image chosen in
that match the selected Viewer Window.
filter display in the area
to the right. E‘ Transfers images on your
I computer to the camera.
Rotates chosen images
[E F 90° to the left or right. The background of chosen images turns blue.

(1) IMPORTANT

e The functions (buttons) that display will differ depending on the camera model.
e Clicking the [ x| (Delete) button will delete the image from the camera. Exercise
adequate caution, as you cannot retrieve the deleted images.

€D < 1 )
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How to Use the Browser Window

Browser Window

This is the main window for performing tasks in ImageBrowser.

Last Acquired Images
You can check images by
shooting date or My Category.

ann
Loy Acquired Images
5 Show All Images

v | Shooting Date

) 200%_0B_11
willimy Category

Display Mode
Selects a display mode
for the Browser Area.

Image Information Panel

When in Preview Mode: Displays information about
the selected image.

When in List Mode: Displays image information if you
click the [File] menu and select [Get Info].

¥ Rasir infnematinn
Filee Marne.
Modifiad:
File Size:
Image Size:
Daea Type:
Sound; "
Lock. ]

¥ Star Rating | My Category

— Browser Area
[y W l

e Displays the images
in the selected folder.

A= A Q| s -] 3 3 H Display Control Panel

Favorine : ﬂ a

l Add | Remave

Configures the settings
for displaying images in

) — o
HideShow Print & Email Send to Trash

Canon Camera
Displays CameraWindow.

View Image
Displays the selected image in the
Viewer Window.

the Browser Area.

1dlmludiﬂnhd.lJruh'. 5 imaon O

Send to Trash

Deletes selected images or folders.

e Deleted images are placed in the Trash.

e |f you mistakenly send an image to the Trash,
click the [Trash] icon in the Dock and restore
the image to its original folder in the Finder.

Slide Show
Displays the selected images in
succession in the window.

Folder Area

Selects a folder to display.

* You can register folders you use often
as Favorite Folders (Eﬁ). Register by
clicking [Add]. To delete a folder in the
Favorite Folders area, select a folder
and click the [Remove] button.

— Print & Email
Prints the selected image(s).
Or creates an image attachment for email.

Rotate Image

e To rotate images, click the [Edit] menu and select [Rotate Image].

e To rotate the original image in the displayed direction, click the
[Edit] menu and select [Rotate According to Rotation Information].

(A ebte of Contents )
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Display Modes

Select a browser area display mode to fit your purposes.

g i | Tl gy

Preview Mode: allows the List Mode: allows
image information to be read thumbnails to be viewed at a
while viewing the image. size suited for easy viewing.

Display Control Panel

This panel adjusts the display settings for the Browser Area.

Display Size Selection Menu
Changes the size of the thumbnail Click this to select/deselect all
in the Browser Area. images in the Browser Area.

View 4,? Filter Taal " | |$| o 9, @L‘ Selecting Images E E E

Filter Tool Menu Hide Buttons
Displays only images that correspond Left:  Hides the Folder Area and the Last
to specific conditions. Acquired Images.

Middle: Hides the control panel.
Right: Hides the Show Shooting Information
panel in the [Preview] display mode.

(' Table of Contents )
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Browser Area Tasks

Functions Used in the Browser Area

Create New Folder
To create a new folder in the Browser Area, click the
[File] menu and select [New Folder].

Select Images

Clicking an image in the Browser Area selects that
image. To select multiple images, hold down the
[shift] key or [§8] (Command) key while clicking
images, or hold down the [option] and [shift] key
together and click a starting and ending image to
select a range of adjacent images.

Display Images

Double-clicking an image in the Browser Area (or

selecting the image and clicking § ), displays it in

the Viewer Window.

Move, Copy Images
To move an image between folders, drag it over the
destination folder and release the mouse button.

Change the Display Size Show Window To copy an image, hold the [option] key while
You can change the size of You can switch between releasing the mouse button as above.
the thumbnails. showing/hiding the Folder

Area, Control Panel and
Information Panel.

@ HINT

Right-Click Context Menus

Right-clicking (or [Control] key and clicking) over a window or image displays contextual menus. These
menus contain the functions available in the current context as well as other convenient functions. Use
the context menus to increase your efficiency.

A
v

(' Table of Contents




Mastering

the Basics

File Information Window

The File Information Window displays when you select an image in the Browser Area,
select [List Mode], and then click the [File] menu and select [Get Info].

File Name
You can change
file names.

Lock

o

S

— Switches between showing and
hiding detail

ed information.

W Star Rating / My Category ’

T = :
E

:‘Y N
1 r'l
| "\l.

-

¥ Comment
Flower !

¥ Key

View/Modify Keywords... )

( Hide Detail |
File Name: | IMG_0001 )
Modified: Aug 11, 2000 2:52:22 AM
File Size: 472 KB (481,938 Bytes)
Image Size: 1600 x 1200
Data Type: Jpo
Sound: o
Lock: N

Brightness Histogram

1
D H

¥ shooting Information

ttem Name | Value

File Mame IMG_0001 . PG
Camera Mod Canon XXX
Shooting Da 0%/08/09 08:15:22
Shaoting Mo Auto

Tw (Shutter § 1/250

A (Aperture 7.1

Light Meterir Center Weighted Awg.
Migital Zrnm Nnne

Image Size 1600x1200

( <Back y) [ Next> )

Image Selector Buttons

When multiple images are selected, you can switch between
images that display information in the File Information Window.

Prevents an image from
being overwritten or deleted.

Y
Image Qualit Fine E

Switches between showing and hiding
detailed information for the category.

Star Rating / My Category
Sets the rating for an image.
An icon will display if a My
Category is set (certain models
only).

Comment
You can type a
comment here.

Keyword
Sets the keywords used in
searches.

Brightness Histogram

A graph of the highlights and
shadows distribution in an
image.

Shooting Information
Displays detailed information,
such as the shutter speed

and exposure compensation
setting. The camera model will
determine what information is
displayed.
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Viewer (View Image) Window

Double-clicking a thumbnail image in the Browser Window displays it in this window.

Change the display

magnification.

Zooming in displays

the Navigator window « » & &b 28 B 530S 2.
to show the relative T il et

position on the image.

| e 2ie s 0 T A | N _—
Save an image.

Shooting information

Set the Star Rating.

L Display the shooting information.

You can configure the

Edit an image. information display by clicking
the [ImageBrowser] menu and
Display multiple selecting [Preferences].

images side by side.

Display at full screen size.

e The [Display Original Image] button will display beneath RAW images in the Viewer Window. Click this

button to display the converted image in the Viewer Window.

e The following window will appear when a movie is displayed.

You can control
movie playback
and sound volume.

You can cut portions

C Save ax S0l Image. 3 E Ct Mo .. )
You can extract (e [ L
stills from movies. i« b & 46 = B 3 5 P,
[ L v [ Hurin if Daplay ybeesist ¥l Sarmn int b

Sherm R G40 W 48D

at either end of a
movie clip.
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Editing Images

(1) IMPORTANT

* The original image will be overwritten after an image is edited unless the file
name is changed before saving it. To preserve the original image intact, change
the file name when saving the edited image.

e This section introduces the procedures for starting from the [Edit] button in the Viewer Window, but you
can also start the same process by clicking the [Edit] menu and selecting [Edit still image].

Trimming-Cropping a Portion of an Image

Use this to delete unnecessary portions of the image and leave only the necessary
portions.

@ Rrocedures \

| Double-click an image.
2 | & | [Edit] and [Trim].

* You can also input values or an aspect
ratio to specify the trim area.

* Movies and RAW images cannot be
edited.

Color/Brightness Adjustment

Adjusts the images’ RGB values (red, green, blue) and the saturation and brightness.

@ Procedures )

| Double-click an image.

2 ["& .| [Edit] and [Color/
we | Brightness

Adjustment].

* Movies and RAW images cannot be
edited.

(‘l‘; ‘a <J o4 ?/\)
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Red Eye Correction

Restores eye appearance to the original color when light reflected from the flash
makes them appear red.

@ Procedures\

| Double-click an image.

2 [ & .| [Edit] and [Red Eye
we | Correction].

* Movies and RAW images cannot be

e Click [Start] when Auto Mode is selected. edited.
e Switch to Manual Mode if Auto Mode cannot correct the e |f a message appears that recommends
image, and select the location of the eye to correct. installation of additional software when

using Mac OS X v10.6, follow the
message to install the software.

Inserting Text

Use this to insert text onto the image.

@) Procedures\

You can freely adjust the font,J | Double-click an image.

size, color and text attributes. .
2 & .| [Edit] and [Insert
Edit Text].

e Placing a checkmark in the [Antialias] box
causes the text edges to blend in with
the underlying image.

* Movies and RAW images cannot be
edited.

A
v
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Correcting Levels

You can adjust the highlights (brightest portions), shadows (darkest portions) and mid-
tone levels of an image while viewing its histogram.

@ Procedures\

| Double-click an image.
2 ["& _| [Edit] and [Level
we | Adjustment].

e Movies and RAW images cannot be
edited.

Correcting Tone Curves

You can adjust the color balance and brightness of an image using its tone curve
(input/output conversion graph of image brightness).

@ Procedures \

| Double-click an image.

2 ["& | [Edit] and [Tone
we | Curve Adjustment].

e Movies and RAW images cannot be
edited.

(A (abte of Contents ) < 2 b
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Adjusting Sharpness-Emphasizing Outlines

Makes images appear sharper by emphasizing the outlines of subjects, such as people
and objects.

@ Procedures )

| Double-click an image.

2 ["& .| [Edit] and
= | [Sharpness].

e Movies and RAW images cannot be
edited.

Auto Adjustment

Automatically adjusts the image color balance and brightness.

@) Procedures \

| Double-click an image.
2 ["& | [Editl and [Auto
= | Adjustment].

e Movies and RAW images cannot be
edited.

{ Table of Contents )
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Using Other Editing Software

If you register another image editing program with ImageBrowser in advance, you can
use that software to edit an image selected in ImageBrowser.

Registering an Editing Program

Register the program so
it can be started from
within ImageBrowser

@ Procedures\

[ImageBrowser] and

I | Other Image [Preferences].
mageBrowser " _ o
Editing Program 2 [Register Application]

Editing Images with a Registered Editing Program
@ Procedures\

1 Double-click an image.

2 ["& .| [Edit] and [Edit
| with Registered
Application].

e The shooting information may be lost
from images recorded with the camera
and then processed and saved with
another image editing program.

e Movies and RAW images cannot be
edited.

-
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Attaching Sounds

You can add sound to images and play back the sounds.

Adding Sound

.D @ Procedures\

] Select an image.

[File], [Sound] and [Record].

* ImageBrowser's Sound Recorder uses
the Mac OS X recording function. If
required, prepare such equipment as a
microphone, and check that recording
is enabled in the [System Preferences],
[Sound] window.

¢ To delete a recorded sound, click the
[File] menu and select [Sound], followed
by [Send to Trash].

e To record a new sound for an image
that already has one associated with it,
click the [File] menu and select [Sound],
followed by [Record].

Symbol displayed on image
thumbnails to which sound
files have been added.

(1) IMPORTANT
¢ Sounds cannot be attached to movies.

Playing an Image Sound File

@ Procedures )

] Select an image.

[File], [Sound] and [Play].

* You can also play sounds in the Preview
Mode and the File Information Window.

- 29 /b/)
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Creating Panoramic Images—PhotoStitch

You can create wide panoramic images by moving the camera slightly when recording
a series of images and merging them into one image.

@ Procedures\

] Select the images that you
want to stitch together.

8 imagerowser Filef( Eait Juiew internet

[Edit] and [PhotoStitch].

* Movies and RAW images cannot be
edited.

Use the PhotoStitch program
to create panoramic images.

@ HINT

Using the Stitch Assist Mode

If you use the camera’s Stitch Assist mode to record the images, PhotoStitch can automatically detect the
image order and merge direction, making it easier to merge the images. (Some camera models may not
feature the Stitch Assist mode.)

(1) IMPORTANT

¢ If a message appears, notifying you that the computer has insufficient memory,
try one of the following methods to solve the problem.
e Close all other applications other than PhotoStitch.
e Reduce the size or number of images to combine.
* In the [Save] tab, select [Adjust image...], then in “Saved Image Size” reduce
the size.

(‘l‘; ‘a <J 30 ?/\)
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Editing Movies

You can create original movies by linking movie clips and still images.
You can even add titles and other text, background music and various special effects
to the movie.

@ @ Procedures \

RN R EENENR N I NENNEEEEE 1 Select an imaQE(mOVieor
¥ B B | still image).

llllll.illlllllllllllllll 2 ® ImageBrowser Tile @ View Internet

# [Edit] and [Movie Edit].

Il al Ty
e You can configure the default settings

for editing movies by clicking the
[MovieEdit Task] menu and selecting

[Preferences].
~ @ HINT ~
Recordable Movie Length
* The length of movies you can save is shown at right. A Movie Size Max. Length
message will appear if you try to save a longer movie. 19201080 Under 10 minutes
Reduce the length or size of the movie if this happens. 12805720 Under 20 minutes
640x480 Under 30 minutes
320x240 Under 60 minutes
\_ ,

(1) IMPORTANT

* Movies edited with this function cannot be transferred back to the camera.

e Saving movies takes time, especially MOV type movies selected with [Save
image type] takes a considerable amount of time.

* There is a file number limit when editing MOV type movies.
To edit and save an MOV movie with a size of 1920 x 1080 at the same size and
file type, set the number of files to 20 or less. Likewise, with 1280 x 720 MOV
movies, the number of files should be set to 40 or less, and with 640 x 480 MOV
movies, 80 or less.

(A oot of contenes ) < a b




More Advanced

Techniques

Converting RAW Images-Digital Photo Professional

You can convert RAW images to JPEG and TIFF images.

Digital Photo Professional’s Main Window @ Procedures\

] Select a RAW image.
2 [} me!..ﬂrnw.s.u@dis View _Internet

[File] and [Process RAW Images
by Digital Photo Professional].

5 Click B

(Edit image window).

4 Adjust the image brightness
and white balance in the
tool palette.

¢ The modified contents (the
information for image processing

Selects folders containing images. requirements) are saved along
with the image as a “recipe”.

e With Digital Photo Professional,
you can adjust images to achieve

Digital Photo Professional’s Tool Palette

You can adjust all three RGB channel the best results for your desired
levels together or separately with the scene or subject by specifying a
Tone Curve. picture style.

e The items available to be modified
Reduces noise that occurs when differ depending on the camera
shooting night time scenery, or model.
when shooting at a high ISO speed. 5oL D.i_si_t!_!._l’.hﬂiﬂ_ei.’mfl‘-!.!-iif -

— Adjusts the brightness, white [File] and [Convert and

balance and picture style. savel.

e After setting the file type, size,
and destination folder, click [Save].

e Only RAW images compatible with Digital
Photo Professional can be processed.

e Ensure that you use the RAW image
conversion software included with your
camera.

— Adjusts the contrast, color tone,
color saturation and sharpness.

€D < 2 )
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To print, using Digital Photo Professional, select an image in the Main Window, then

click the [File] menu and select the print function. Digital Photo Professional offers the

following printing methods.

Printing Method Description

Single Print

Automatically sets the layout for printing a single image on a single page.

Detailed Setting

Gives you the freedom to set the layout, add titles, or print with shooting information.

Contact Sheet

Prints a line-up of multiple images on one page (also allows you to select the number of
images, layout, and add titles).

(1) IMPORTANT

e RAW images can only be captured on certain camera models that list "RAW" as one of
the data types included in the “Specifications” section of the Camera User Guide.

e Only RAW images compatible with Digital Photo Professional can be processed. Check
the “Data Type” item of the “Specifications” section of the Camera User Guide for

compatibility.

* For a more detailed explanation of operating procedures, download the Digital
Photo Professional manual (PDF format) from the Canon website.

~ @ HINT
About RAW Images

RAW images contain the data captured by the camera’s image sensor without modification. Since
they contain raw data that differs from the usual JPEG images by not having any image adjustment or
compression processing performed in the camera, they can be converted on a computer with a lossless

process.
Processing in the Camera Processing by Computer
O Image Adjustment <7
Standard Image . ,
. Can be used with general programs.
Capture Compression JPEG Image * Image is subject to degradation when
Image sensor Image adjustment adjusted because it has been compressed.
data from & compression Digital Photo Professional
shutter release | automatically performed RAW Image Processing
RAW Image (Image Adjustment)
Capture (RAW Image JPEG Image,
( Compression ) TIFF Image

® You can view the image while making
adjustments without worrying about quality
loss.

e Processing with Digital Photo Professional
is required to view the images with general
programs.

\_
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Exporting
Changing Image (Stills) Sizes and Types

You can change an image’s size and format when exporting it so that it can be
published on the Internet or attached to an email message.

@ Procedures )

| Select an image.

[File] and [Export Image].
3 [Edit and Save Image]
4 [Next>]

e You will lose the shooting information
if you save images as a type other than
JPEG.

Exporting Shooting Information.

You can export the shooting information recorded with an image, such as the shutter
speed and exposure, as a text file.

@ Procedures \

] Select an image.

[File] and [Export Image].
3 [Export Shooting Properties]
4 [Next >]

failed photos or compare the

Ascertain the causes of
settings for several images.
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Creating Computer Screen Saver Images

You can export images to serve as computer screen savers.

@ Procedures\

] Select an image.

[File] and [Export Image].
3 [Export as a Screensaver]
4 [Next >]

Creating Computer Wallpaper Images

You can export images to serve as computer wallpaper images.

@ Procedures\

] Select an image.

[File] and [Export Image].

3 [Export an Image as
Wallpaper]

4 [Next >]

< 3 p)
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Extracting Stills from Movies

You can extract and save stills from your favorite frames recorded in a movie.

IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII @ Procedure\

poal el w! b s S

] Select an image.
) _# imagebrowser il [ Edit Jview Internet

[Edit] and [Extract frames
from a moviel.

shots as stills

Extract your bestJ

<« 3 )
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Uploading Movies to YouTube
Uploading to YouTube

You can upload movies you have shot to YouTube. You can upload movies saved on

the camera or a computer.
//l‘\\ @ Procedures \
(e t the camera
ll'..l‘ t: r;;nc(ca)cmputer to start
“" .‘ CameraWindow.

e For details, refer to steps 1- 2 in
“Transferring Images”.

[Upload Images from
Cameral]

[Upload Movies to YouTube]
Select movies.

Click [2] (Next).

Input a title and description,

then click [2] (Upload).

Enter your YouTube
username and password,
and sign in.

I %

| NGO AN W N

Uploading Movies Saved on a Computer

In the [Applications] folder, select the [Canon Utilities] folder, then in the [CameraWindow] folder, select
the [CWUTtility] folder, and double click the [Movie Uploader for YouTube] icon. Click [Add] in the screen
that appears, then after adding movies to the upload list, click the || (Upload) button.

(1) IMPORTANT

e Depending on YouTube specifications, or future changes to specifications, this
function cannot be guaranteed.

* The maximum length for uploadable movies is less than 10 minutes, and the
maximum file size is less than 1 GB.

e Movies that have been edited on a computer cannot be uploaded.

e Internet access is required to upload movies (You must already have an account
with an Internet service provider (ISP), browser software installed and an
Internet connection).

e Any ISP account charges and access fees must be paid separately.

(A Teble of Contents ) « 7 )
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Attaching Images to Email

You can send images as email file attachments.

@ Procedures\

| Select images.

2 [&_ [Print & Email] and
rustmal [Create Image for
Email].

the image size and

You can configure
quality settings.

* You can configure how the email
program automatically starts up by
opening the [Applications] folder, and
double-clicking the [Mail] icon to start
the Mail program, and clicking the [Mail]
menu, followed by [Preferences] and the
[General] tab.

* Images in the [Email Images] folder can
be found by opening the [Users] folder
on the startup disk, followed by the [User
Login Name], [Library], [Preferences],
[ImageBrowserUserData] and [Mail]
folder.

(1) IMPORTANT

¢ If the e-mail software does not start automatically, first save the images to your
computer, then start your e-mail software to attach and send the images. The
destination folder for saved images can be set with [Custom Settings].

<« = )
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Slide Shows

Viewing Images in Slide Shows

A multiple selection of images can be shown at full size on the screen in succession as

a slide show.
You can freely configure the T M\
transition effects, information @ Procedures
displayed and display time settings. | Select images.

2 [T@ I[SlideShow]

SlideShow

]
=

* You can configure the slide show display
method by clicking the [View] menu and
selecting [Slide Show Options].

~ @& HINT N
Slide Show Button Functions
The following buttons appear at the bottom of the screen while a slide show is playing.
You can set the Star Rewind =—— Pause p=—— Forward
Rating for an image
while it is displayed.  Go to first image -| r Advance to last frame
mma‘@@@@@o
After the slide show, After the slide show, Stops the slide show.
the images you the images you clicked
clicked during the during the show appear
show remain selected. in a printing window.
\_ J
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Image Management

Changing File Names in Batches

You can change the file names of multiple images in one procedure.

@ Procedures \

] Select an image.

9 L& uma_eam View _lnternet _
Name + Number |

el [File], [Organize Image] and

| Shooting Date + NumberJ [Rename].
r
Name + ShotingDete + Namber | Changerandoly | fou r hnge e fe 21

T numbered images . . q th the Fil
Shooting Date + Name + NumberJ and received images name in Preview mode or with the File

numbered images. e Changing the image name in
ImageBrowser also changes the actual
file name on the disk.

xxx_04 xxx_05

Sorting Images into Folders by Shooting Date

You can sort images into folders by their shooting dates.

@ Procedures\

] Select an image.

[File], [Organize Image] and
[Sort Images].

3 [The files will be separated
into folders for each
shooting date.]

4 [Next >]

Images predating your use
of ImageBrowser can also
be managed together.

_’
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Classifying Images Into Star Ratings Folders

You can classify images according to their Star Ratings into separate folders.

@ Procedures\

| Select an image.

[File], [Organize Image] and
[Sort Images].

3 [The files will be organized
by star rating.]

4 [Next >]

You can organize the images
you have recorded according
to their Star Ratings.

{4
- EEE

- — .

{ Table of Contents )




More Advanced

Techniques

Configuring Image Information Settings

Setting Star Ratings

You can set the Star Ratings used in searching and displaying images in the index list.

@ Procedures\

] Select an image.

2 (i—-u-.u-h_lz) List Mode |
Switch to [Preview Mode].

3 Set [Star Rating].

* You can also set the Star Ratings by
accessing the [Edit] menu, the File
Information Window or the Viewer
Window.

W ¥ : Ultimate
W :Moderate
w : Okay

Inserting Comments

You can freely insert your choice of text as Comments.

@ Procedures )

] Select an image.

7 (O pevewmoce ) stwode |
Switch to [Preview Mode].

3 Insert [Comment].

e Comments can also be managed in the
File Information Window.

as comments

Your choice of textJ

(A | rebte of Contents ) < 2 p
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Assigning Keywords

You can set Keywords for use in image searches.

@ Procedures )

] Select an image.

O (O pevenmoce ) istwode |
Switch to [Preview Mode].

3 Set [Keyword].

e Keywords can also be managed from the
[Edit] menu or File Information Window.

* To add keywords, click the [Edit] menu
and select [Manage] from the [Keyword]
submenu.

~ @ HINT |

About Image Information
This chart shows the information other than shooting information that can be added to images.

Information Type | My Category Star Ratings Comments Keywords

Content

Categories such as
People, Scenery, etc.

Categorized on a
basis of 3 rankings:

Text input without
restriction regarding
the shooting
circumstances

Selections are made
from a list (editable)
of keywords, such

as the photographic

W, WK, WKW \ _
or associated subject, place or
memories. action.

Configuration Configured in . .

Method Camera Configured in ImageBrowser

Used in Searches — 0 0 O
Us_ed as Filter 0 0 o o
Criteria

Display beneath

Thumbnail 0 0 0 o

submenu.
.

Categories displayed beneath thumbnails can be selected from the [View] menu and [View Settings]

(A Tobre of Contens )
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Searching, Filtering and Sorting Images

Searching Images

You can search images using parameters extracted from the information associated
with them.

@ Procedures\

1 8 ImageBrowsed{ File Jrdit View Internet

[File] and [Search].

e After a search, the correlated images
display in the [Search Results] folder.

All Folders

Date J IOk Search Results

Favorite photo
Keyword Comment J "ﬁ Pictures
r (12009 08 07
k (]12009_08_08
ﬂ [112009_08_09

(12009 08 _10
| '§2009_08_11
|'§2009 0812

Tasks Related to Search Results

You can select images in the [Search Results] folder and perform operations on them, such as printing or
copying them to other folders.

(1) IMPORTANT

e Please note that deleting an image from the [Search Results] folder deletes the
original image. Use caution in deleting items from this folder.

(A )(ebre of Contents ) < 4 p
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Filtering Images

You can use filters to display only images meeting the selected parameters in the

Browser Area.
“

Q Procedures\

1 oF Filter Toal -
[Filter Tool]

This section is used to specify the filter criteria.

I 1

oy Mudh

e e I T B
&

Canan Camers Vi image it Print & Lol St ta Trath

“ion. ol b Seacnd 0 | Tecik | heagas 8

Sorting Images

You can sort images in the Browser Area based on the specified parameters.

ol e[ kel e
File Namc-: i

Ascending/
Descending

,‘I‘

[View] and [Sort].

File Modification Date Shooting Date/TimeJ

File Size

5
®
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Comparing Images

Comparing Multiple Images

When a good photo opportunity arises, you can shoot the same subject using different
shutter speeds and exposures. In ImageBrowser, it is easy to compare images so that
minute differences can be detected.

@ Procedures \

| Select several images to
compare.

2 | m [ViewImage]

View Image

3 23 _ | Select a view

mumber of oisplays | Method from
[Number of
Displays].

4 & [Synchronize]

Synchronize

e Selecting [Synchronize] causes actions
such as increasing/reducing the
magnification level or scrolling around
the image to apply to all of the selected
images in lock step, making it easy to
check minute details of focus, coloring
and other image characteristics.

| 75K

2 R ik % 2 ¥ .
« 2 @. 1. & = = 0.
Bk L] | St Eds Humbes of Srachmese Tl Jereen L hmlﬂ

(et

gt 71605 1440 |

Actions performed on an image, such as scrolling or changing the
magnification, are performed on the other image as well.
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My Camera Settings

Changing the Shutter Sound and Start-Up Image

You can select from dedicated screens to register to the start-up screen that appears
when turning the camera on, and dedicated sounds to register to various camera
operation sounds (My Camera Settings).

My Camera Settings @ Procedures\

e Start-up Image

e Start-up Sound | Connect the camera

* Operation Sound to a computer to start

e Selftimer Sound :

« Shutter Sound Camerandow. |
— e For details, refer to steps 1- 2 in

/ “Transferring Images”.
m 2 [Camera Settings]
—p

Select the desired item from
the following and make
settings.

» [Set Start-up Image]
» [Set Sounds]
» [Set Theme]

(1) IMPORTANT

e My Camera Settings are only available on certain models, when [Camera
Settings] displays in CameraWindow.
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My Camera Settings
registered in the camera.

My Camera Settings

Stan-up Image Sentingu

! Bl camera Start=up Image List

XMASZ? _SHI1

You can register the

, : 2 KhAg22 S101 B 2215010
start-up image, start-up -
sound, shutter sound, -
operation sound Bl oo
and self-timer sound
collectively if you select ANMALD22 5101 7
[Theme]. E ANIMALOZ3_SI01JPG

K BARZ1_SI01IPG

CHIMPANZT_SID1JPG

After choosing a My Camera Settings file from the left-hand list,
select a My Camera Settings file to replace in the right-hand list
and click this button to register it in the camera.

@ HINT

Downloading My Camera Settings Files
You can also download various files to use in My Camera Settings from CANON iIMAGE GATEWAY.

(A ebre of Contents ) < @
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Transferring Images

Transferring Images to a Camera

Images transferred once to a computer can be transferred back to the camera.

@ Procedures )

] Connect the camera
to a computer to start
CameraWindow.
e For details, refer to steps 1- 2 in
“Transferring Images”.

2 [Organize Images on

Cameral]
Show favorite images I 3 [Organize Images]
to friends or connect :
a TV to show them 4 @ (Upload)

on a large screen. 5 Select images.

e |f ImageBrowser's Browser Window is
open when the camera is connected
(directly after transferring for instance),
open the CameraWindow (menu screen)
by clicking the [Canon Camera] icon
in the Control Panel of the Browser
Window.

(1) IMPORTANT

e Cameras that use the “MOV” data type can play back movies transferred back to
the camera if movies were taken with that camera. Refer to the “Data Type” item
in “Specifications” near the end of the Camera User Guide to see if the camera
uses the “MOV"” data type. You may not be able to play back movies taken with
another camera.

* Only still images compliant with Design rule for Camera File system standards
can be transferred to your camera’s memory card.

e You may not be able to transfer images back to the camera if they have been
edited on a computer, or if the image information has been modified.
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CANON iMAGE GATEWAY

About CANON iMAGE GATEWAY (for U.S.A. customers only)

CANON iMAGE GATEWAY is an online photo service for the purchasers of this product.
Registering online allows you to use the various services.

(1) IMPORTANT

¢ Internet access is required to use CANON iMAGE GATEWAY (You must already
have an account with an Internet service provider (ISP), browser software
installed and an Internet connection).

e See the homepage for information regarding browser versions (Safari, etc.) and
settings to best connect to CANON iMAGE GATEWAY online photo services.

* Any ISP account charges and access fees must be paid separately.

Registering
First, register as a CANON iMAGE GATEWAY member.

e © reiue

I [ & . [CANON iMAGE
4/‘\\\| CANON S Registerradd
* | M A@E Product].
W

GATEWAY * You can register online using the

supplied CD-ROM. To do this, in the
installer panel, click [Register] underneath
CANON iIMAGE GATEWAY.

canon DIGITAL CAMERA
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Available Services

CANON iMAGE GATEWAY offers a variety of convenient and useful services.

Upload and
P share images

Create your own photo album
on CANON iMAGE GATEWAY
E-mail notifications
of album uploads

7

Friends and family can
freely browse images

Access even from
mobile phones

1

@) Procedures\

@ . [CANON iMAGE
awonuc: GATEWAY]

Select the desired item from
the following and make
settings.

» [Register/Add Product]
» [Top Page]
» [Upload Images]

» [View Online Photo
Album]

» [Download My Camera
Contents]

Order prints J

r

My Camera Settings Files on
CANON iMAGE GATEWAY

Download files for My Camera
Settings (certain models only)

Also, you get the k

latest customer
* support information, <
~ just for registering

~— your product
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Preference Settings

Customizing ImageBrowser

You can configure ImageBrowser to operate according to your preferences.

~N

AEIREBCELOARSEE S BUIE
———

e Overall coloring, such as @ Proc
window appearances

* Processing methods for 1 :
images shot with the
camera on end [ImageBrowser] and

 Categories of shooting [Preferences].
information displayed

e Show/hide messages

e Print settings
* Registering applications I

edure

Sl

{ Table of Contents )
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List of Available Functions

CameraWindow Functions

Function Names

Description of Function

Import Images
from Camera

Import Untransferred
Images

Only transfers images from the camera that have not yet been transferred.

Select Images to Import

Only transfers chosen images from the camera.

Import All Images

Transfers all images from the camera.

Organize Images
on Camera

Organize Images

Protect, rotate, and delete images on the camera. Also transfers images
back to the camera from your computer.

Upload Images
from Camera

Upload Movies to
YouTube

Uploads movies on the camera to YouTube.

Camera Settings

Set Start-up Image

Sets the camera start-up screen.

Set Sounds

Sets camera sound effects (start-up sound, shutter sound, operation
sounds, self-timer sound).

Set Theme

Sets the camera start-up screen and sound effects in My Camera Settings.

Preferences

General (General/
Connected Camera)

Sets the camera owner name, and start-up screen when CameraWindow
starts.

Import (Auto Import/
Folder Settings/After
Import)

Sets the automatic transfer settings and destination folder.

ImageBrowser Functions

Control Panel Functions

Function Names

Description of Function

Canon Camera

When a Camera is
Connected

Connects to the camera to open CameraWindow (menu screen), and use
CameraWindow functions.

When a Memory Card
Reader is Connected

Transfers images from a memory card. You can also select images on the
memory card and print them.

Album

View Image Displays the selected image or movie in the Viewer Window.
SlideShow Starts a glide show of ’;he selected imag.es. Click the [View] menu and
select [Slide Show Options] to set the slide show settings.
Register/Add Product | Connects to CANON iIMAGE GATEWAY and opens the registration page.
Top Page Connects to CANON iIMAGE GATEWAY and goes to the top of the page.
CANON iMAGE Upload Images Connects to CANON iMAGE GATEWAY and uploads images.
GATEWAY View Online Photo

Connects to CANON iIMAGE GATEWAY and displays albums created.

Download My Camera
Contents

Connects to CANON iIMAGE GATEWAY and downloads images and
sounds for use with My Camera Settings.

(‘ L) _Table of Contents
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Function Names

Description of Function

Print & Email

Photo Print

Prints one image per page. You can print “photos” easily.

Index Print

Lines up small versions of the images in rows and prints.

Layout Print

Allows you to freely arrange multiple images on a single page and print.
You can also insert captions and titles.

Create Image for Email

Converts the selected images to the appropriate size for transmission by
e-mail. You can also use it to automatically start an e-mail program after
conversion.

Send to Trash

Sends the selected images or folders to the Trash.

Functions Selected from Menus

Function Names

Menu

Description of Function

Search Images

[File] menu, [Search]

Searches for images based on such criteria as Star Ratings, dates,
keywords or captions.

Export Images

[File] menu, [Export
Image]

Edit and Save Image

Allows you to change the file type or size and export the file.

2RI ALeEg Allows you to export the shooting properties as a text file.
Properties

Export asa Exports the image as a screen saver file.

Screensaver

Export an Image as
Wallpaper

Exports the image as a wallpaper file.

Organize Images

[File] menu, [Organize
Image], [Sort Images]

Sorts images according to criteria such as the shooting date or Star Rating
and saves them into a specified folder.

[File] menu, [Organize
Image], [Rename]

Changes the files names of multiple images in a single pass.

Convert RAW

[File] menu, [Process
RAW Images by Digital

Converts RAW images into JPEG or TIFF images. You can adjust the image
brightness, contrast and color balance among other attributes during

Edit]

Iigfes Photo Professional] conversion.
" [File] menu, [Rewrite
Writing to .
Image to Memory Transfers images from the computer to the memory card.
Memory Card
Card]
ieige [Edit] menu, Merges multiple images and creates a single large panoramic image
Panoramas [PhotoStitch] 9 P 9 g gep 9e -
Edit Movie [Edit] menu, [Movie Edits movies or still images strung together. You can add text as titles, or

background music, and apply various effects.

Extract frames

[Edit] menu, [Extract

Extracts still images from movies over a specified interval and saves them

from a movie frames from a movie] | as image files.

Disolav Settings [View] menu, [View Hides or shows image information beneath the thumbnail, such as the file
play g Settings] name or the shooting date and time.

Sort Images Whezws | i, [Ser Arranges image order in the Browser Area according to criteria such as

the filename, file modification date, file size or shooting date.
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Supported Image Types

The following is a list of image types supported by ImageBrowser.

JPEG

Most cameras use this image type. It compresses at very high ratios, taking advantage
of the characteristics of the human eye. However, because it is an irreversible
compression method (part of the data is lost during compression), if you process and
save an image repeatedly using this method, the image may become rougher.

Exif JPEG is an image type that adds information such as shooting data to a JPEG
image.

RAW

This is a proprietary image type provided by Canon. It allows the output of the image
pixels from a digital camera without any deterioration in the quality of the image.
Some cameras might not support this image type.

PICT

This is the standard image type for Macintosh. This image type is supported by most
Macintosh software.

TIFF

This is a relatively popular image type. It is widely supported by non-Macintosh
programs (such as Windows).

BMP (Windows Bitmap)
This image type comes standard with Windows. Most Windows programs support it.

AVI (.AVI)

Standard Windows movie type. The movie thumbnail and a movie icon show in
ImageBrowser’s Browser Area.

MOV (.MOV)

Movie type. The movie thumbnail and a movie icon show in ImageBrowser’s Browser
Area.

(A ebre of Contents ) =B
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Uninstalling the Software

The procedures for uninstalling the software are only required when you wish to
delete the programs from your computer or when reinstallation is required to fix
corrupted files.

(1) IMPORTANT

e Computer administrator status is required to perform the following operation.
e Please be careful not to accidentally delete any folders with downloaded images
that may be contained within the application folder.

" Move all of the application folders from the installation destination
folder to the trash.

2 Empty the trash.
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Memory Card Folder Structure

Images on the memory card are in either the [DCIM] folder’s [xxx___mm] folder, or the
[xxx_mmdd] folder (xxx: numbers 100 to 999, mm: shooting month, dd: shooting day).

- .-

xxX_mmdd

IMG_xxxx.JPG (JPEG images)

_MG_xxxx.JPG (JPEG images recorded in the Adobe RGB color space)
IMG_xxxx.CR2 (RAW images)

_MG_xxxx.CR2 (RAW images recorded in the Adobe RGB color space)
STx_xxxx.JPG** (Stitch Assist mode images)

MVI_xxxx.MQOV, MVI_xxxx. THM* (Movies)

MVI_xxxx.AVI, MVI_xxxx. THM* (Movies)

j The folder that holds the settings files
‘ for images in the DCIM folder:

CANONMSC
| ‘ The folder created when DPOF settings are set.
It holds the DPOF settings files.

MISC

e * These files are the thumbnail image files for the camera’s index replay mode. If
you delete these files, you will be unable to transfer movies to the camera from a
computer.

® The “xxxx" in file names represent four-digit numbers.

e ** Each successive file shot in Stitch Assist mode is assigned a letter starting from
“A," which is inserted as the third digit in the name. i.e. [STA_0001.JPG], [STB_0002.
JPG], [STC_0003.JPG]...

e All folders except the “xxx__mm” or “xxx_mmdd" folders contain image settings
files. Do not open or delete them.

e Depending on the camera, some data types cannot be recorded.
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Troubleshooting

Please read this section if you encounter a problem using the software.

Start by Checking This

Investigate the following points first if you encounter a problem.

Does your computer satisfy the requirements listed in the System
Requirements section?

See “System Requirements” in the Camera User Guide.

Is the camera correctly connected to the computer?

See the Camera User Guide for the correct connection procedures. Also check to
ensure that you are using the correct cable and that it is securely attached at both
ends.

Are the camera and computer in the correct modes to transfer data?

Some models require the camera to be set to the playback mode to transfer data. See
the Camera User Guide for details.

Is the battery sufficiently charged?

Check the battery charge if you are powering the camera with a battery. You are
recommended to use an AC adapter (sold separately) to power the camera when it is
connected to a computer.

Problems

You can‘t find transferred images.
Refer to “Changing the Transfer Destination Folder” to confirm where the destination
folder is.
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Software Guide Macintosh
(ImageBrowser, PhotoStitch)

Disclaimer

e While every effort has been made to ensure that the information contained in this guide
is accurate and complete, no liability can be accepted for any errors or omissions. Canon
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.

e No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior written
permission of Canon.

e Canon makes no warranties for damages resulting from corrupted or lost data due to a
mistaken operation or malfunction of the camera, the software, memory cards, personal
computers, peripheral devices, or use of non-Canon memory cards.

CDP-E089-010 © CANON INC. 2010
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